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Switching from one photo management appli-
cation to another is a traumatic endeavor in a 
photographer’s life. It’s like changing schools as 
a child. You don’t know any of the other kids, 
and you don’t know where anything is. It’s just 
lonely. At least at first.

But I’m here to help you with that. Think of 
me as the kid who slides up next to you at the 
lunch table and asks your name.

“Hi, I’m Derrick. Are you new here?”

Yes, a new friend on the first day of school. 
What a relief. Followed by your first insider tip.

“Oh, and don’t even think about eating that 
meatloaf. There are horrible things in there.”

Maybe things are going to be alright after all.

You see, I’ve been that new kid, too. I was 
happily rolling along using Aperture to run my 
photography business in Northern California, 
when one day I received an email from Apple. 

“We wanted to let you know that we will no longer be developing 
Aperture.”

DERRICK STORY

Moving to Capture One Pro
FROM LIGHTROOM OR APERTURE

What?! That’s like dad coming home and telling the family that 
we’re moving to Wisconsin. Nothing against that great cheese 
state, but I haven’t a clue about the place. For all I know, they 
might not even make cheese anymore.
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that you do are recorded as instructions, which are then reflected 
visually in a fresh new preview file.

You can add metadata, change the appearance of the photo, and 
output to a variety of file formats. In the Library tab, you can orga-
nize your work by folders (called Groups), projects, and albums. 
Your master images can be stored inside the Capture One catalog 
container (the managed approach) or stored on a separate hard 
drive (a referenced catalog).

The interface of the application can be adapted to your personal 
tastes (Figure 1). As you move from left to right in the Tool Tabs area, 

That’s the way I felt about the news from Apple.

I then proceeded to go through the five stages 
of grief. First, denial. “There’s no way they’re 
really going to pull the plug.” Next, anger. 
“Those dirty son-of-a-guns. How dare they take 
away my livelihood.” Then bargaining, depres-
sion, and finally…acceptance.

And that leads us to this e-book. After months 
of research and testing, I decided that Capture 
One Pro would be the new home for my photos. 
And now that I’ve been here for a while, I’m 
really quite comfortable. Yes, I still miss my old 
friend Aperture. He was a great guy. But there’s 
nothing I can do about that (acceptance). 

So here we are, together, poised to do one of 
the hardest things in modern photography: 
making the move from one software to another. I’ll start by provid-
ing a little background about Capture One Pro. Then, I’ll cover strat-
egies for making the move. And I’ll augment our time together 
with a few insider tips to steer you away from danger.

I’m glad you’re here. I think we’re all going to get along just fine.

What Is Capture One Pro?
In all honesty, it’s not that much different from Lightroom and 
Aperture, at least not on the inside. Capture One Pro is a database-
driven, non-destructive photo editor and image management 
system. The RAW files are preserved in their original state. Any edits 

Figure 1: Capture One Pro’s interface
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When it’s time to share your work with the world, you have two 
basic export options: You can select Export Images under the File 
menu, or you can use a Process Recipe from the Output tab. In fact, 
you can output a photograph in multiple formats all at the same 
time by applying more than one process recipe. How nifty is that?

I’m sure this all sounds great, maybe even familiar. But how do you 
try these tools on a few of your images? Excellent question. I’ll cover 
that next.

you’ll encounter a series of icons, each contain-
ing a set of tools. The Color and Exposure tabs, 
for example, contain the sliders that you’d 
expect, such as white balance and contrast, 
respectively. Not only can you change the order 
of these tabs, you can also add and subtract 
tools within them.

If your camera is supported (and more than 
400 are), you can edit your RAW files here. Plus, 
Capture One handles TIFFs and JPEGs, too, but 
not Photoshop files (your first insider tip). So 
if you’re a heavy Photoshop user, this will be a 
problem for you.

You can make virtual copies of your images. They 
are called variants. And they behave much like 
their counterparts in Lightroom and Aperture. 
So, for example, you can perform basic edits on 
a picture, then make variants with different crop proportions.

Speaking of edits, there are two general types of edits available: 
global and local. The global edits change the entire picture. So if you 
increase the warmth of an image, that’s reflected corner to corner. 
If you want to work on a specific area, then go to the Local Adjust-
ments tab, and select one of the tools available there (Figure 2).

To help you organize your images, you can apply star ratings, color 
tags, and keywords. You can also create a nested structure with 
projects and albums to help you keep track of your images. This all 
happens in the Library tab.

Figure 2: Lots of local adjustments are available in Capture One Pro



while learning the ropes. I will go so far as to say that if you don’t 
adopt the test library approach, please stop right here. I hope you 
follow my advice on this matter.

I will help you create these test libraries. I’ve written this guide 
for both Lightroom and Aperture users. Each of you get your own 
sections covering the steps required for learning how to import 
small libraries into Capture One Pro.

After testing, consider the wisdom of moving your entire existing 
image catalog to Capture One Pro. My recommendation is that you 
don’t. Instead, bring over select batches of photos from your old 
application, then use Capture One Pro for your new stuff moving 
forward.

As for the remainder of your legacy work 
housed in Aperture or Lightroom, I would opt 
for setting up an older computer to handle 
these archives. Then, just export content from 
them as needed. I understand that this is a 
conservative approach. But it’s also a sane 
one. At least think about it as you read on.

Creating a Test Library 
in Aperture
Find an album in your existing Aperture 
library that contains 15–30 images. Create a 
library from this album by right-clicking on 
its icon and choosing Export > Album as New 
Library from the popup menu (Figure 4).

Transition Strategies
Let’s start with what I think you should avoid: I recommend 
that you should not try to move your entire Lightroom or Aper-
ture library into Capture One Pro at one time. The results of this 
approach are often disastrous. Trust me, it’s worse than eating 
school meatloaf.

Instead, what I recommend is that you create a test library (or test 
catalog in Lightroom) that is a small subset of the existing cata-
log, then import that into Capture One (Figure 3). Why? Because 
you’re creating an opportunity to learn and experiment. There will 
be surprises. And you don’t want to risk your precious image library 

Figure 3: A Lightroom test catalog
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Once you’ve been notified that the process is complete, you can 
switch to that test library for some fine-tuning. In Aperture, go to 
File > Switch to Library > Other/New. A new dialog will present itself 
with all of the available Aperture libraries. Highlight your test library 
on the list and click Choose (Figure 6). Aperture will open it.

The next step is to create a mini version of your standard Aperture 
library. Make sure all of the images in this test have star ratings and 
keywords. Add color tags to some and flags to others. Create addi-
tional albums and nest them in a folder. Create a slideshow. 

Even though you only have a handful of images, you can use them 
to build a scaled version of the structure that you use in your main 
library on a grander scale. We’re doing this so you can compare what 
you created in Aperture to what later appears in Capture One Pro.

Ready for another one of those insider tips? Smart albums won’t 
make the journey to Capture One. You can test this for yourself, but 
trust me, it doesn’t work. So if you have content in smart albums 
that you want to bring over, select all of the images in the smart 

In the dialog that follows, you’ll be asked to give it a name and 
choose its location (Figure 5). Be sure to give it a distinctive “test” 
name so you don’t confuse it with your regular work. I keep my test 
libraries in a folder on the desktop, then discard them once I’ve 
completed a trial run.

In that same dialog, check all 
three boxes at the bottom. 
By doing so, you’ll ensure 
that all the necessary compo-
nents of the library are in one 
container, and that you’ll be 
notified once the export is 
complete. Then click the blue 
Export Library button.

Figure 4: Selecting an album to export as a New Library

Figure 6: Opening your test library in Aperture
Figure 5: Choosing a location 
for your test library
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album and create a regular album from them (File > New > Album, 
or Command-L).

If you have a lot of smart albums in your library, I realize that this can 
be a rock in your shoe. It’s one of the tasks to consider when decid-
ing how much content to bring from one application to another.

Once you’ve finished fine-tuning your test library, close Aperture. 
You’re now ready to import it into Capture One Pro and review the 
results.

Importing an Aperture Library into 
Capture One Pro
Now that you have a test library ready to go, you can see 
how well Capture One Pro’s import tool works. Start by 
opening a fresh Capture One Pro catalog. Hold down the 
Option/Alt key while launching the application (Figure 7).

After a few moments, a dialog should appear. Click on 
New Catalog in the lower left corner. When the next dialog 
appears, give your catalog a name, choose a location, and 
click OK. A fresh, new Capture One catalog should appear 
(Figure 8).

On the left side of the interface, the Library tab should be 
highlighted in the Tool Tabs with the following listings in 
that pane:

•  Catalog Collections

•  User Collections

•  Folders

Figure 7: Hold down the Option/Alt key while launching the applica-
tion to open this dialog box

Figure 8: A fresh Capture One catalog before importing pictures
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like a folder) will appear under User Collections. Open the Group 
and everything beneath it by clicking on the angled brackets to the 
left of the icon. You should see a project container and your albums 
(Figure 10).

Click on any of the albums, and thumbnails should appear in the 
viewer window. Capture One Pro will build its own previews for these 
images. You can enlarge any thumbnail by double-clicking on it. The 
image will enlarge and a filmstrip of thumbnails will be placed below 
it. This is the default location for the thumbnails. If you’d like your 
thumbnails to be placed on the right side, go to View > Place Browser 
Right. Most photographers like this better for portraits.

Some of your image edits from Aperture should be reflected in 
these imported photos: crop (or straighten), rotation, flip, exposure, 
brightness, highlights & shadows, definition, saturation, and B&W 
adjustments.

Catalog Collections are set by the application. They include stan-
dard ways to look at your pictures, such as All Images and Recent 
Imports.

User Collections is the area where you’ll organize your catalog. 
Here’s where you can create a structure with projects and albums.

Folders shows you what’s happening on the hard drive where your 
masters are stored. If you’re using a managed catalog, then every-
thing is stored within the Catalog icon. If you choose to run a refer-
enced catalog, then you’ll see a hard drive with the file folders that 
contain your master images. 

So let’s bring in some pictures and see how this works. Go to File > 
Import Catalog > Aperture Library (Figure 9). You’ll be greeted with 
a nice little information pane that tells you what’s going to happen 
next. Read it, then click Continue.

Navigate to your Aperture test library and click the Open button. 
Capture One will import the contents, and a Group (which looks 

Figure 9: The command to import your Aperture test library

Figure 10: A successfully imported Aperture library
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stay inside the Aperture library container. If you’re running a refer-
enced library, then Capture One honors that structure, too. You can 
test this by creating a referenced library in Aperture and perform-
ing another dry run.

That being said, what are our options for the current import? 
First, you could leave the images where they are in the Aperture 
container. Understand that the Aperture container must remain 
available in this scenario. You can’t throw it away.

Second, you could move that numbered folder out of the Aperture 
container to a more suitable location, such as to a connected hard 
drive (Figure 11). 

You can perform this task right here in Capture One Pro. Here are 
the steps:

1. Connect an external hard drive to your computer that you wish to 
contain the masters.

You can return to the all-thumbnail view by clicking Option/Alt-
Command-V. You can control the size of the thumbnails via the 
Zoom Tool in the upper right corner of the interface. Take a few 
moments to peruse your pictures. My experience has been that 
they looked at least as good as they did in Aperture, if not better.

Let’s return to the Library tab on the left side. Take a look at the 
structure that Capture One created based on the information in 
your Aperture library. The contents should look very similar.

The first time I did this, I was really impressed with the results. And 
generally speaking, the Capture One structure has been very close 
to what I created in Aperture.

After spending some time reviewing User Collections, take a look at  
the Folders area. Here you’ll see a Catalog icon. That’s where the data- 
base, previews, and other components in the catalog are stored. 

Below that, you should see a hard drive icon. Open it by clicking on 
the angled bracket to its left, and you should see a folder labeled 
by a numbered sequence. This is where your master images are 
currently stored on the drive. You can see them by clicking on the 
folder.

By default, Capture One sets up a referenced catalog when import-
ing Aperture libraries. To see the location of this folder, right-click 
on it and choose Show Folders Hierarchy. If you were running a 
managed library in Aperture, you would be taken into its depths. 
Right-click again and choose Hide Folders Hierarchy to collapse the 
structure.

The bottom line here is that when you use the Import from Aper-
ture command, Capture One leaves the masters in their current 
location. So, if you have a managed Aperture library, the masters 

Figure 11: An external hard drive that will be the new home for your 
master images



6. Perform the actual move of the masters. This happens in Capture 
One. Click on the folder with the images in it to display them in 
the browser. In the illustration, that folder is labeled “20151211-
215205.”

7. Select all of the images in the browser (Command-A), then drag 
them to the new folder in the library pane (Figure 12). In my case, 
that folder is “12-15 Crystal Lee Portraits.”

8. Capture One will relocate the masters to their new home in the 
folder you’ve created (Figure 13).

Here’s the really important part! If you perform the above steps, 
your master images are no longer in the Aperture container. You 
have just moved them. If you want to use that library in Aperture, 
you will have to point the application to their new home. (In this 
example, that is the “12-15 Crystal Lee Portraits” on the external 
SanDisk drive.) This is one of the reasons why working with a test 
library is so important.

2. In Capture One, click on the + icon to the right of Folders (in 
the Library tab), and navigate to the external hard drive you just 
connected.

3. Click the blue Add button, and the drive should be added to the 
list in Capture One, right there beneath your computer hard drive 
icon.

4. Click on the external drive once to highlight it (in the illustrations 
here, it’s labeled SanDisk 128GB), the click the + icon again to add 
a folder to the drive. 

5. Create the new folder by clicking on the New Folder button in 
the dialog, then give it a name, such as Aperture Masters. Click 
the blue Add button. (If you want additional nested folders inside 
the Aperture Masters folder, create that now, too. I created one 
called “12-15 Crystal Lee Portraits”.)

Figure 12: Selecting all the images to move

Figure 13: The images successfully relocated to the external hard drive
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A Note About Importing  
Referenced Libraries
If you’ve been using a referenced library in Aperture—in other 
words, storing your masters outside the Aperture library container—
then importing a test library into Capture One Pro is even easier.

Capture One will leave the masters where they’re currently stored, 
and point to them in the Folders area of the Library tab (Figure 15).

You still have the same flexibility for relocating the masters, as I 
discussed earlier. Just keep in mind that you’ll want to do all of 
your organization within the Capture One interface.

Your third option is to create a managed catalog inside Capture 
One Pro. This is quite easy. Just select all of the thumbnails again, 
and this time drag them to the Catalog icon. They will now be 
stored in the Capture One Pro Catalog (Figure 14). They no longer 
reside on your external hard drive.

None of this activity affects what happens in the User Collections 
area. All of your 3-Star albums and other virtual collections will 
behave the same. That’s because Capture One Pro is database-
driven. So it’s keeping track of these masters despite all the moves 
we’ve made.

The important point to remember is to make these moves inside 
the Capture One interface. If you go behind its back and work on 
the Finder level, then links will be broken and problems will surface. 
So stay within the interface, and everything will be all right.

Figure 14: Images relocated to the Capture One Pro Catalog

Figure 15: Masters from a referenced Aperture library will be left in 
their current location and Capture One will show you that location  
in the Folders area of the Library tab

Creating a Test Catalog in  
Lightroom
Find a collection in your Lightroom catalog that contains 15–30 
images. Right-click on the collection name and choose Export this 
Collection as a Catalog (Figure 16).



What you want to do is create a mini version of your standard 
Lightroom catalog. Make sure all of the images in this test have star 
ratings and keywords. Add color tags to some and flags to others. 
Create additional collections. Make a little slideshow. 

Even though you only have a handful of images, you can use them 
to build a scaled version of the structure that you use in your main 
catalog on a grander scale. We’re doing this so you can compare 
what you created in Lightroom to what later appears in Capture 
One Pro (Figure 18).

Ready for another one of those insider tips? Smart collections won’t 
make the journey to Capture One Pro. You can test this for yourself, 
but trust me, it doesn’t work. So if you have content in smart collec-
tions that you want to bring over, select all of the images in the 
smart collection and create a regular album from that selection.

Designate a location, such as a folder on your desktop, and give it 
a distinctive test name so you don’t confuse it with your everyday 
Lightroom catalogs. I also recommend that you check the boxes 
next to the options to “Export Negative Files” and “Include Avail-
able Previews.” Then click the Export Catalog button. Lightroom will 
place three items in a folder in your designated location: a catalog 
file, a data file, and a folder containing the masters (Figure 17).

Double-click on the catalog file (.lrcat) to open it in Lightroom. 
You’ll want to do a little housekeeping now to clean up the cata-
log and add any goodies that you want to test for importing into 
Capture One Pro.

Figure 16: Exporting a collection as a catalog

Figure 17: Lightroom’s exported files

Figure 18: Try to create a mini version of your Lightroom catalog so 
you can test the variables that are important to you
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your catalog a name, choose a location, and click OK. A fresh, new 
Capture One catalog should appear (Figure 20).

On the left side of the interface, the Library tab should be high-
lighted in the Tool Tabs with the following listings in that pane:

•  Catalog Collections

•  User Collections

•  Folders

Catalog Collections are set by the application. They include stan-
dard ways to look at your pictures, such as All Images and Recent 
Imports.

User Collections is the area where you’ll organize your catalog. 
Here’s where you can create a structure with projects and albums.

Folders shows you what’s happening on the hard drive where your 
masters are stored. If you’re using a managed catalog, then every-
thing is stored within the Catalog icon. If you choose to run a refer-

If you have a lot of smart collections in your catalog, I real-
ize that this can be a rock in your shoe. It’s one of the tasks 
to consider when deciding how much content to bring from 
one application to another.

Once you’ve finished fine-tuning your test catalog, close 
Lightroom. You’re now ready to import it into Capture One 
Pro and review the results.

Importing Your Lightroom Test  
Catalog into Capture One Pro
Now that you have a test catalog ready to go, you can see how well 
Capture One’s import tool works. Start by opening a fresh Capture 
One catalog. Hold down the Option/Alt key while launching the 
application (Figure 19).

After a few moments, a dialog should appear. Click on New Cata-
log in the lower left corner. When the next dialog appears, give 

Figure 19: Hold down the Option/Alt key while launching the applica-
tion to open this dialog box

Figure 20: A fresh Capture One catalog before importing pictures
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be placed below it. This is the default location for the thumbnails. 
If you’d like your thumbnails to be placed on the right side, go to 
View > Place Browser Right. Most photographers like this better for 
portraits.

Some of your image edits from Lightroom should be reflected in 
these imported photos: crop, rotation, orientation, exposure, white 
balance, saturation, and contrast adjustments. You should also see 
star ratings and color labels, but flags won’t survive the trip.

You can return to the all-thumbnail view by clicking Option/Alt-
Command-V. You can control the size of the thumbnails via the 
Zoom Tool in the upper right corner of the interface. Take a few 

enced catalog, then you’ll see a hard drive with the file folders that 
contain your master images. 

So let’s bring in some pictures and see how this 
works. Go to File > Import Catalog > Lightroom Cata-
log (Figure 21). You’ll be greeted with a nice little 
information pane that tells you what’s going to 
happen next. Read it, then click Continue.

Navigate to your Lightroom test catalog (.lrcat) and 
click the Open button. Capture One will import the 
contents, and a Group (which looks like a folder) 
will appear under User Collections. Open the Group 
and everything beneath it by clicking on the angled 
brackets to the left of the icon. You should see a proj-
ect container and your collections (Figure 22).

Click on any of the collections, and thumbnails 
should appear in the viewer window. Capture One 
will build its own previews for these images. You can 
enlarge any thumbnail by double-clicking on it. The 
image will enlarge and a filmstrip of thumbnails will 

Figure 21: The command to import your Lightroom Test Catalog

Figure 22: A successfully imported Lightroom Catalog
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1. Connect an external hard drive to your computer that you wish to 
contain the masters.

2. In Capture One, click on the + icon to the right of Folders (in 
the Library tab), and navigate to the external hard drive you just 
connected.

3. Click the blue Add button, and the drive should be added to 
the list in Capture One, right there beneath your computer hard 
drive icon.

4. Click on the external drive once to highlight it (in the illustrations 
here, it’s labeled SanDisk 128GB), the click the + icon again to add 
a folder to the drive. 

5. Create the new folder by clicking on the New Folder button in 
the dialog, then give it a name, such as Lightroom Masters. Click 
the blue Add button. If you want additional nested folders inside 
the Lightroom Masters folder, create that now, too. I created one 
called “09-15 Ariah Senior Portraits” (Figure 23).

6. Perform the actual move of the masters. This happens in Capture 
One. Click on the folder with the images in it to display them in 
the browser. In the illustration, that folder is labeled “09-15 Ariah 
Senior Portraits” under the Macintosh HD icon.

7. Select all of the images in the browser (Command-A), then 
drag them to the new folder in the Library pane (Figure 24). In 
my case, that folder was “09-15 Ariah Senior Portraits” under the 
SanDisk 128GB icon.

8. Capture One will relocate the masters to their new home in the 
folder you’ve created (Figure 25).

moments to peruse your pictures. My experience has been that 
they looked as least as good as they did in Lightroom, if not better.

Let’s return to the Library tab on the left side. Take a look at the 
structure that Capture One created based on the information in 
your Lightroom catalog. The contents should look very similar. A few 
collections may be in a different position. But unless they were a 
smart collection previously, they should be present in the new cata-
log. The first time I did this, I was really impressed with the results.

After spending some time reviewing User Collections, take a look 
at the Folders area. Here you’ll see a Catalog icon. That’s where 
the database, previews, and other components in the catalog are 
stored. 

Below that, you should see a hard drive icon. Open it by clicking on 
the angled bracket to its left, and you should see a folder labeled 
with your master images. This is where they are currently stored on 
the drive. You can see them by clicking on the folder.

You can leave your masters here, or you can connect an external 
drive and move them to that location. Here’s how to do that:

Figure 23: The new 
home for the master 
images is created and 
waiting to be popu-
lated
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Figure 24: Pictures selected to move to the new location

Another option is to create a managed catalog inside of Capture 
One Pro. This is quite easy and something new to Lightroom users. 
Just select all of the thumbnails again, and this time drag them to 
the Catalog icon. They will now be stored in the Capture One Pro 
Catalog (Figure 26). They no longer reside on your external hard drive.

None of this activity affects what happens in the User Collections 
area. All of your 3-Star albums and other virtual collections will 
behave the same. That’s because Capture One Pro is database-
driven. So it’s keeping track of these masters despite all the moves 
we’ve made.

The important point to remember is to make these moves inside 
the Capture One interface. If you go behind its back and work on 
the Finder level, then links will be broken and problems will surface. 
So stay within the interface, and everything will be all right.

Figure 25: The images successfully relocated to the external hard drive Figure 26: Images relocated to the Capture One Pro Catalog
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As you can see in Figure 27, my adjustment to Expo-
sure and Highlight were migrated to Capture One 
Pro. I’m showing you this now because I think it’s 
worth testing. The transferable adjustments from 
Aperture include: crop (or straighten), rotation, flip, 
exposure, brightness, highlights & shadows, defini-
tion, saturation, and B&W. You may want to apply 
each of these in your Aperture test library, then see 
how they look in Capture One.

Next, we’ll take a look at the Color tab. Let’s see how 
a Lightroom import does. I’ve worked on one of the 
images in the test catalog, then reimported the cata-
log into Capture One to see how my edits transferred. 
The shot I worked on in Lightroom can be seen in 
Figure 28.

A Closer Look at the Imported  
Image Edits
Before I leave you to your own devices, let’s take a look at two more 
Tool Tabs: Exposure and Color. I chose to examine these because 
this exercise will give you an opportunity to see if any image edits 
survived the import process. We’ll start with the Exposure tab.

The Exposure tab is four to the right of the Library tab we had been 
working in. By default, it includes tools for Exposure, High Dynamic 
Range (which is really just Highlights and Shadows), Levels, Curve, 
Clarity, and Vignetting.

Figure 27: You can see that both adjustments to the Exposure and 
Highlights sliders appear in this image imported from Aperture

Figure 28: Edited image in Lightroom
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Now take a look at Figure 29 to see how it looks in Capture One Pro.

We’ll start in the Color tab, which is two to the right of the Library 
tab. The first thing I notice is that my White Balance change in 
Lightroom did not transfer to Capture One Pro. However, the crop 
did. In fact, take a look at the thumbnail (at the top right in Figure 
29) that shows both the crop and the original image. Nice!

Moving back to the Exposure tab (Figure 30), I see that the Contrast 
and Saturation changes did come over, too. So, we got three out of 
four on this one.

So, here’s the bottom line. You’re not going to get all of your edits 
transferring over to Capture One Pro. But you will get some very 
important ones, such as cropping. 

Where to Go from Here
Now that you have some test images in Capture One Pro, this is a 
great time to learn more about the application. I suggest that you 
purchase Capture One Pro 9: Mastering Raw Development, Image 
Processing, and Asset Management, published by Rocky Nook. This 
guide will help you master all of the editing functions of Capture 
One Pro…and a lot more. 

I recommend that you learn these techniques using your test 
library. Take chances, move things around, try everything. You have 
nothing to lose.

After some practice, you’ll be better equipped to decide what your 
strategy is going to be for making the move from Aperture or Light-
room. I’ve done it. And I couldn’t be happier.

Figure 29: Here’s the image after being imported into Capture One 
Pro

Figure 30: We did get Contrast and Saturation, however
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Author’s Note
I wrote this e-book for two reasons. The first is because I want you 
to have a good understanding of how to begin the move from 
Aperture or Lightroom over to Capture One Pro. I hope I’ve helped.

Here’s the second reason, which I also feel strongly about. Rocky 
Nook is a terrific publisher of photo books with many great authors. 
And I want more people to be exposed to their catalog. I’m hoping 
that this e-book will help with that.

Please share the download link with your friends and encourage 
them to be a part of the Rocky Nook community. By doing so, not 
only will they receive their legitimate free copy of this guide, but 
they will learn about the other books we have to offer. We promise 
we won’t abuse your trust in us.

—Derrick Story
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